USER’S GUIDE

FoodWise 1.2

diet analysis software
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System Requirements

· Windows ‘98, 2000, ME, XP

· Pentium 166 MHz or higher recommended

· 32 MB hard drive space

· 800 x 600 x 16 bit color, 32 preferred

· 4x CD-ROM 

· Mouse

· Internet Explorer 5.1 or newer, Netscape 7.1 or newer (optional)

Installation Instructions:


Windows:

1. Insert the CD.

2. Go to Start, Run, D:\setup.exe (or click on your CD drive and double click on setup.exe).

3. Follow the step-by-step instructions

4. Select FoodWise from the Start, Program menu.

Installation Instructions for installing FoodWise to a computer lab network can be obtained by contacting your McGraw-Hill sales representative regarding a site license.  www.mhhe.com
Getting Started on Your Diet Analysis:

1. Click on FoodWise in the program list.  Click on FoodWise, then FoodWise (Diet & Exercise Analysis). 
2. The first time you use FoodWise, you must create a unique Profile in which to store your data.  Click on Create a New Profile.  A screen will appear that asks you where you want to save your data:
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NOTE:  If you are using FoodWise in a computer lab, you will likely need to save your data to a floppy disc.  Insert a floppy disc and click the down arrow next to the Save In: box.  Select the Floppy drive (typically the A: drive).  

Next click on Create New Folder icon (top right of screen) and type in a title for your folder, e.g., Lydia’s Analysis. Click in the File Name box and type in a file name, e.g., Lydia’s Foods.  Once you have done this, click Save and the Personal Data screen will appear.  

FoodWise will then automatically save all data you enter as you work through the program.  If you are using FoodWise on your own computer, you can save your data on a floppy disc or to your hard drive.

3. Read the Help window, and then click Close This Display.

4. Click the File Menu (Optional) (upper left corner of the main control panel).  Click Set Preferences.  Change preferences as indicated by your instructor.  If no changes are needed, click OK.

5. Click Personal Data (main control panel on the left) 

a.  
Enter your name, age, height, weight, gender, and activity level.

b. If you choose to enter specific activities for a typical day instead of an activity level, click Specified Activities, then Choose Activities.   Select your activities and the amount of time spent in each activity.  Once you have completed a day’s worth of activities, click OK and the balance of the day’s time will be automatically calculated as sleep.  
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6.  Click Food List (main control panel on the left)

a. If a list of foods (not yours) already appears in the right-hand box, click the Delete Entire List button (top right).

b. To select a food, type in the food name (up to five words) in the Search Phrase box. Then hit Enter, or click on Search the Database.  Example:  To find a cinnamon roll, type cinnamon roll or just cinn roll or even cinnamon, or roll.
IMPORTANT: Food Search Tips
1. You can search for up to five words at once.  However, it is usually best to keep your search simple by using fewer words (e.g., Instead of French cut green beans, try green beans).

2. Do not use plurals (use egg, instead of eggs).

3. Check your spelling.  If unsure, you can search using short segments (e.g., scram, instead of scrambled).

4. Use the word raw when searching for fresh produce.

5. If your search brings up a very long list of foods (e.g., apple has 123 entries), you can enter a second term to narrow down your search (e.g., pie) and click Search This List.  You will then be able to choose from 14 entries that contain both apple and pie.
6. To exclude foods containing a certain word, put a negative sign (-) before the word.  For example if you are looking for a sweet, but don’t want sweet potatoes, enter sweet –potato. (Note:  There is a space between sweet and the minus sign.)

7. Check out the Abbr? button to learn the abbreviations used in the food list.  This is especially helpful for Fast Foods (e.g., BK=Burger King)

8. Read the food descriptions very carefully as there are sometimes similar versions of the same food.  E.g., check whether you want orange juice concentrate or prepared.  
9. If the food description is too long to read in the Database List box, use the Choose Display Window View drop-down menu to widen the box

c. If your search produces a very long list, you can narrow it down by entering an additional search word and clicking Search This List.  Example:  You enter apple and retrieve a long list of foods.  Then enter pie and Search This List to get a shorter list of selections to choose from.

d. Click on the food you ate to highlight it.  Double click on your selected food, or click Add This Food.

e. When the Food Item Selection window opens, click on 

· Serving size choice (or select grams, ounces, or pounds) 

· Enter the Number of servings of that serving size you ate

· Indicate which Meal you ate the food 

· Indicate the Day you ate it.  

· Then click on Add This Food.
 It is very important that you enter this information carefully for each food.  Accurate food selection information is critical to properly analyze your diet.
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f. If you made an error in entering a food item selection, click to highlight the food in your food list.  Click Show Details.  Click Change and make the needed corrections. Then click Make the Change, and Close This Display.

g. To delete a food from your food list, click to highlight the food, then click Delete Item.

h. To select a food already chosen on a previous day, click on the food in your food list, click on Show Details and then Re-Select.  Edit Serving Size, Servings, Meal, and Day if needed.  Click on Add This Food.

i. Continue these steps until all the foods in your Diet Record are entered.
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5.   Click Display Results (main control panel on left)

a. After you have entered the foods for all the days in your Diet Record, chose the appropriate Analysis Mode (single day, single meal, average by day).  Once you have selected the analysis mode, select the appropriate day, meal, or range in the right column.

b. To review the analysis before printing, click Analyze (lower right corner).  (Click on Next Page to view all analysis screens.)  After you finish looking at the analysis screens, click Close This Display.

c. NOTE: If you then add additional foods to your list, you must click Analyze again to be sure that all your food choices are included in the analysis reports.
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Printing Reports: 
You can print reports in two ways:

6.    After you have analyzed your final data, click Print Reports (main control panel on the left).  Then select the reports specified by your instructor.  This feature includes a Print Preview so you can be sure you are printing the correct report.

OR 

7.  Click Display Results and you can select Print for each individual report as you view it.

8.   When you are finished, click the X in the upper right-hand corner or go to the File Menu.  Click Exit.

Returning to Work on an Existing Food List:

9.  Open the FoodWise program.  (If you saved your file to a floppy disk, insert the disk and then open the FoodWise program as usual.)

a. Select Open Profile.  In the Look In: box, select the location where your file is stored.  (i.e. Lydia’s Analysis folder).  Click on your file’s name (i.e. Lydia’s Foods.txt).  Then click Open (lower right corner).

b. Click Personal Data (main control panel).  The personal data will reflect the data you saved in your file.  Click Food List (main control panel).  The food list loaded from the file will now appear in the right box.  You can now add or delete foods from your food list.

Adding Foods to the User Database:

10. Click the Edit Menu (main control panel upper left)

a. Click Edit the User Database. 

b. Click on the? Help button for detailed instructions for adding foods to your user database.
c. When you have finished adding nutrient values for each food, click Save.  You will now be able to include this food in your Food List search.
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Single User License Agreement

LICENSE AGREEMENT, LIMITED WARRANTY, AND DISCLAIMER
PLEASE READ THIS ENTIRE AGREEMENT CAREFULLY BEFORE USING THIS SOFTWARE.  This agreement is legally binding upon you, any end user, and McGraw-Hill.  By using this software, you are agreeing to each term of this agreement, including the software license, limited warranty and disclaimer.  

As a party to this License Agreement, you, the Licensee, agree to the following terms and conditions.

1.
SOFTWARE OWNERSHIP.  AS THE LICENSEE, YOU OWN THE CD-ROM(S) ON WHICH THE PROGRAM (“Software”) is recorded or fixed.   McGraw-Hill and its licensors shall retain full and complete title to the Software recorded on the enclosed CD-ROM(S) and all subsequent copies of the Software, regardless of the media or form on or in which the original CD-ROM(S) or other copies may exist, including copies which are made in violation of the terms of this License.  This License shall not be considered a “sale” of the original Software.

2.
LICENSE GRANT.  In consideration of payment of the Licensee fee, which is a portion of the price you paid, McGraw-Hill grants to Licensee a nonexclusive right to use and display this copy, and only this copy, of the Software on a single computer on a single video screen at a single location.  All rights not expressly granted to Licensee are reserved to McGraw-Hill.

3.
COPYRIGHT RESTRICTIONS.  This Software and the accompanying content (printed, written, digital or otherwise) are copyrighted.  Unauthorized copying of the Software, including those instances where the Software has been modified, merged or included with other Software, or of the accompanying content, for any reason, is expressly forbidden.  Licensee may be held liable for copyright infringement which results from such unauthorized copying.

4.
RESTRICTIONS ON USE.  Licensee may physically transfer the Software from one computer to another, provided that the Software is used on only one computer at any one time.  Except for the initial loading of the Software on a hard disk or for archival or backup purposes, Licensee shall not, without the prior written consent of McGraw-Hill (such consent to be granted or withheld at McGraw-Hill’s sole discretion for any reason),


(a)
copy, reproduce or publish the Software;


(b)
electronically transfer the Software to multiple computers over a network system;


(c)
distribute copies of the Software or accompanying materials to others;


(d)
modify, adapt, translate, reverse engineer, decompile, disassemble or create derivative



works based on the Software; or


(e)
modify, adapt, translate or create derivative works based on the printed, electronic, 



or written accompanying content;


(f)
resell the Software or any content;


(g)
loan, rent or lease the Software or any content;


(h)
transfer the License or related rights.

5.
TERMINATION.  This License Agreement will automatically terminate if Licensee fails to comply with any term of this Agreement.  No notice shall be required from McGraw-Hill to effect such termination.  Upon termination, Licensee shall immediately destroy the software, all copies thereof, and the printed and written materials, or return all of the same to McGraw-Hill at Licensee’s expense.

6.
SOFTWARE UPDATES.  Updated versions of the Software may be created or issued by McGraw-Hill from time to time.  At its sole option, McGraw-Hill may make such updates available to the Licensee or authorized transferees who have returned the registration card, paid the update fee, and returned the original CD-ROM to McGraw-Hill.

LIMITED WARRANTY AND DISCLAIMER

McGraw-Hill warrants that the physical media on which the program is furnished under normal use will be free from defects for sixty (60) days from the date of delivery to you by McGraw-Hill or McGraw-Hill’s authorized representative or distributor.  Your receipt shall be evidence of the date of delivery.

The Software and accompanying materials are provided “as is” without warranty of any kind, either express or implied.  The complete risk as to the quality and performance of any non-warranted program is with you.  Should the program prove defective, you assume the entire cost of all necessary servicing, repair, or correction.

McGraw-Hill and its licensors make no warranty or representation that the functions contained in its program will meet your requirements or that the operation of the program will be uninterrupted or error free or that the program defects are correctable.

THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING BUT NO LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY MCGRAW-HILL, ITS DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS LIMITED WARRANTY.  THE DURATION OF ANY IMPLIED WARRANTY SHALL BE LIMITED TO THE DURATION OF THE LIMITED WARRANTIES SET FORTH HEREIN.

REMEDIES.  McGraw-Hill’s entire liability and your exclusive remedy shall be limited to replacing the defective media if returned to McGraw-Hill or an authorized representative of McGraw-Hill (at your expense) accompanied by dated proof of purchase satisfactory to McGraw-Hill not later than one week after the end of the warranty period, provided you have first received a Return Authorization by calling or writing McGraw-Hill in advance.  This warranty shall not apply if the CD-ROM has been damaged by negligence, accident, improper or unreasonable use, or by any other causes unrelated to defective materials or workmanship.

THE MAXIMUM LIABILITY OF McGRAW-HILL AND ITS LICENSORS SHALL BE THE PURCHASE PRICE OF THE SOFTWARE.  IN NO EVENT SHALL McGRAW-HILL AND ITS LICENSORS BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL, SPECIAL, EXEMPLARY OR PUNITIVE DAMAGES FOR TORT, CONTRACT, STRICT LIABILITY OR OTHER THEORY, ARISING OUT THE USE OF, OR INABILITY TO USE, THE SOFTWARE, EVEN IF McGRAW-HILL OR McGRAW-HILL’S AUTHORIZED REPRESENTATIVE WAS PREVIOUSLY ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY OTHER CLAIM BY YOU OR ANY OTHER PERSON.  IN ANY EVENT, McGRAW-HILL AND ITS LICENSORS’ LIABILITY SHALL BE LIMITED TO THE TOTAL AMOUNT PAID BY THE LICENSEE.  SOME STATES DO NOT ALLOW LIMITATIONS ON THE LENGTH OF AN IMPLIED WARRANTY OR THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSIONS MAY NOT APPLY TO YOU.  THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE.

ENTIRE AGREEMENT.  This Agreement contains the entire understanding of the parties hereto relating to the subject matter hereof and supersedes all prior or contemporaneous representations or agreements of the parties whether written or oral.  No waiver or modification of any of the terms hereof shall be valid unless in writing and signed by all parties.  No waiver of any breach shall be deemed a waiver of any subsequent breach.  If any provision of the Agreement is held to be invalid or unenforceable, the remaining provisions shall be affected.

GOVERNING LAW.  This Agreement and Limited Warranty are governed by the laws of the State of Iowa.
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